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This window is an example showing pictures when [Filmstrip] has been selected fr
the [View] menu in Explorer. 

Note

This section describes how to synchronize information on your PDA (calendars, contacts, inb
etc) with your PC using Microsoft ActiveSync.
When you connect via Bluetooth instead of with a standard cable, you will always be able to
synchronise your data without the hassle of having to connect the cable. 

→Connecting using ActiveSync
→Establishing a partnership between ActiveSync and a PDA
→Finishing an ActiveSync connection
→Cancelling a partnership

Please use ActiveSync v.3.7 or higher. Also please establish a partnership between the 
devices using a USB or infrared link before you connect via Bluetooth. 
Please refer to the ActiveSync Help or other manuals for information on how to use the
application. 
Microsoft Outlook 2002 or another schedule management tool must also be installed on
PC. 

Important

Synchronising information using ActiveSync [SPP]
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Both the PC and PDA must be set up in order for a connection to be established.

■Preparing the PC

1. On the PC, click on [Start]→[All Programs]→[Microsoft ActiveSync]
The initial ActiveSync set-up window will appear.
It is assumed in the explanation below that no ActiveSync connections have been
established with other devices.

2. Click [File]→[Connection Settings]

The [Connection Settings] window will appear.

3. Place a check next to [Allow serial cable or infrared connection to this COM por
and then select "COM7".

Connecting using ActiveSync

Procedure
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In the standard set-up, the port is configured to "COM7" (refer to Steps (3)
(4) under "Preparing the PDA" below). When using a different port, please
change the port number selected in this window. 

■Preparing the PDA

1. Tap on the Bluetooth icon in the bottom right of the screen

 

The graphic above shows an example of a PDA operating window.
The connection procedure may be different depending on the manufacturer
model of PDA you use. Please refer to the product instruction manuals for 
further details. 

The[BluetoothSettings]windowwillopen

Note

Procedure

Important
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The [Bluetooth Settings] window will open.
The message "Connection not registered" will appear if no Bluetooth device has 
registered.

Please tap on [OK] to close the message.

2. Double click on [Tools]→[Search for peripheral components]

The application searches for nearby Bluetooth devices.

3. Tap and hold on the destination PC icon, and then select [Update Services]
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A search for services will be carried out, and then a list of service names and the
connection status will appear as list in the lower window.

4. Tap and hold on "COM7" from the list of service names, and then select "Registe
ActiveSync".

5. Tap [OK] in the confirmation message window
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An ActiveSync connection will be initiated.

Once a connection has been successfully established with a PDA, the procedure for 
establishing a partnership with the PDA will be started by the ActiveSync application on 
PC.
Performing this set-up procedure will enable data to be synchronised between your PC a
PDA.

1. In the [New Partnership (Set Up a Partnership)] window, select "Standard 
partnership", and then click on the [Next] button

The [New Partnership (Specify Data Synchronisation Method)] window will appe

Establishing a partnership between ActiveSync and a PDA

Procedure
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2. Select "Synchronise with this PC", and then click on the [Next] button

The [New Partnership (Select Synchronisation Settings)] window will appear.

3. Select the type of information to be synchronised between your PC and PDA, and
click on the [Next] button

The [New Partnership (Completing Setup)] window will appear.

4. Click on the [Finish] button
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When you click on the [Finish] button, ActiveSync will begin to synchronise you
information.

[Confirming changes]

　　　　　　　　　　↓
　　　　　　　　(Synchronisation process)
　　　　　　　　　　↓

[Synchronisation complete]

While the ActiveSync connection is active, synchronisation will be performed 
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While the ActiveSync connection is active, synchronisation will be performed 
whenever information is changed on either the PC or the PDA.

Once a partnership has been established, every time you start your PC (and PDA
thereafter, a Bluetooth connection will be opened and ActiveSync will synchroni
your information.

Follow the procedure below on your PDA if you want to end an ActiveSync connection 
manually.

1. Tap and hold on "COM7" in the Bluetooth Settings window, and select [ActiveSy
Release]

Follow the procedure below from the ActiveSync window on the PC if you want to canc
partnership between your PC and PDA.

1. Click on [File]→"Delete partnership"

Finishing an ActiveSync connection

Procedure

Cancelling a partnership

Procedure
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Click on the [Yes] button when the confirmation message appears.

If you wish to create another ActiveSync connection, you will have to repe
above procedure to re-establish a partnership. 

　 

Note

This section provides a description of how to use a Bluetooth -compatible wireless headset to
communicate (chat) using Microsoft NetMeeting or other software. 

→Registering the headset
→Making a connection to the headset
→Disconnecting from the headset

1. Right-click on the Bluetooth icon in the tasktray, then click on [Add New Conne
Wizard]

 

Registering the headset

Procedure

Using a headset to communicate [HSP]
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Alternatively, you can click on [Start]>[All Programs]>[Bluetooth]>[Blueto
Settings], then click on [New Connection] in the [Bluetooth Settings] scree
has opened. 

The [Add New Connection Wizard (Welcome to the Add New Connection Wizar
screen will appear.

2. Turn the headset power on
Once you have turned on the headset, set the mode to enable a Bluetooth connect

The procedure for operating the headset may differ depending on the 
manufacturer and model.
Please consult your user guide for a detailed description of how to operate 
unit. 

3. Confirm that [Express Mode] has been selected, then click on the [Next] button

The [Add New Connection Wizard (Searching for Bluetooth Devices)] screen wi
appear.

Note

Important



Introduction 第 165 頁，共 224 頁

file://C:\Documents and Settings\anitachou\Local Settings\Temp\~hh114B.htm 2004/11/30

Once the device search has been completed, the [Add New Connection Wizard (S
a Device)] screen will appear.

4. Select the name of the headset device from the list, then click on the [Next] butto

5. Answering with the headset
If the service has been properly detected, a screen will appear indicating that the 
headset is being called, and a tone will accordingly sound in the headset.

Please press the headset switch. 

The procedure for operating the headset may differ depending on the 
manufacturer and model.
Please consult your user guide for a detailed description of how to operate 
unit. 

The [Add New Connection Wizard (Configuring (Connecting to Voice Circuit))]
screen will appear, and device configuration will be performed.

Important
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If you are connecting to the headset for the first time, or if another Bluetoo
audio device has not yet been registered, the following [Found New Hardw
Wizard] screen will appear, from which you can proceed to install the drive

If another audio device has already been registered (i.e., the driver has been
installed), you can proceed to Step 9 without having to install the driver. 

6. Click on the [Next] button

The [Install Hardware] screen will appear.

7. Click on the [Continue Anyway] button
The following screen will appear automatically. You may disregard it and click o
[Continue Anyway] button.

The [Add New Connection Wizard (Completing the Found New Hardware Wizar
screen, which is the final screen of the installation wizard, will appear.

8 Clickonthe[Finish]button

Note
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8.Click on the [Finish] button

Once driver installation is complete, the [Add New Connection Wizard (Enter 
Connection Name)] will appear.

9. Confirm the information you have entered, and click on the [Next] button

The [Add New Connection Wizard (Completing the Add New Connection Wizar
screen will appear.

10. Click on the [Finish] button

The configuration information will be registered, and an icon will be displayed in
[Bluetooth Settings] screen.
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You can make a connection to the headset from an icon that has been registered in [Blue
Settings].

Before making a connection to the headset, please check that you have turned on th
headset's power, and that it has been enabled for a Bluetooth connection.
Please ensure that the following audio-related applications have been closed before
connect the headset to your PC. 

Windows Media Player, BeatJam, InterVideo WinDVD and other music/audi
playback software 
Windows Messenger and other e-conferencing software 

If you wish to use these applications, please terminate the headset connection befor
launch them. 

1. Right-click on the headset icon, then click on [Connect].

2. Answer with the headset
 
A screen will appear indicating that the headset is being called, and a tone will 
accordingly sound in the headset.
Please press the headset switch.

Making a connection to the headset

Important

Procedure
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If the connection has been properly established, the icon's appearance will change
indicate a connected state.

You may now launch conferencing and voice-recognition software and use the 
headset.

Please follow the steps below to disconnect from the headset.

1. Right-click on the headset icon in the [Bluetooth Settings] screen, then click on 
[Disconnect].

A message will appear, requesting confirmation that you wish to disconnect. Clic
the [Yes] button.
The icon on the [Bluetooth Settings] screen will appear as shown below, indicatin
that the device has been disconnected.

Disconnecting from the headset

Procedure

For security purposes, you may not wish your device to be detected by other Bluetooth users
procedure for accomplishing this is provided below.

Making a device undiscoverable to other users
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1. Right-click on the Bluetooth icon in the task tray, and click on [Device Propertie
Security]

The [Device Properties] window will appear.

2. Select [Non-discoverable mode] in [Discoverability mode] under the [Security] t
and then click on the [OK] button

Your device will now be undetectable by other users, even when they search for 
devices.

Other devices are still able to establish connections with your device even if you ha
enabled the Non-discoverable mode.
Please enable "Non-connectable mode" if you wish to reject connections from othe
devices.

Related topic: "Bluetooth Manager"

Procedure

Note
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Since Bluetooth communication is conducted wirelessly, there is always the possibility that a
party may be able to intercept your transmissions.
You can use encryption to render the content indecipherable to anyone who manages to inter
it.

Encrypting your transmissions will still not guarantee complete security. Accordingly, 
please be aware that transmitting data is conducted with an element of risk for the user

1. Right-click on the Bluetooth icon in the task tray, and click on [Device Propertie
Security].

The [Device Properties] window will appear.

2. Select [Link Level Enforced Security] in [Security Mode] under the [Security] ta
a check next to [Encryption], and then click on the [OK] button

Important

Procedure

Encrypting the content of your transmissions
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Once you have configured the security mode, a window will appear when you first
a connection to another device, prompting you to enter a Bluetooth passkey (PIN c
Please click on the [OK] button after you have entered the passkey.

The window in which you enter the passkey will not appear once you have connect
more than two times to the device.

Related topic: "Bluetooth Manager" 

Note

The "default connection" refers to the dial-up connection configured for use whenever a 
connection is made to the Internet.
If several connections have been registered, you can change the default connection by follow
the procedure below.

1. Start Internet Explorer

2. Click on [Tools]→[Internet Options...]

The[InternetOptions]windowwillappear

Procedure

Changing the default connection
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The [Internet Options] window will appear.

3. Click on the [Connections] tab

In this window, "Direct Connection" is set as the default, and "Never dial a 
connection" has been selected.
Change the settings so that "London A" will always be dialled when you connect
the Internet.

4. Select "Always dial my default connection"
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5. Click on "London A", and then click on the [Set Default] button

"London A" has been changed to the default connection.

 

Alternatively, if you wish to connect to the Internet from a LAN in a company or o
environment where a LAN can be accessed, select "Never dial a connection" if you
a dial-up configuration, but do not want dial-up to occur automatically.
When connecting to the Internet via a LAN, you must enter the appropriate LAN 
settings under [LAN Settings...]. 

Note
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This section describes how to send business card data wirelessly using Microsoft Outlook 

The explanation below relates to an example in which Microsoft Outlook 2002 has bee
used to perform the procedure. Subtle differences may arise when using other versions 
software. 

You can send business card data directly from the "Contacts" window in Outlook.

1. Start Microsoft Outlook, and open the "Contacts" window

2. Double-click on the contact whose details you wish to send as a business card

The details of the contact you selected will appear.

Note

Sending business card data

Procedure

Sending business card data from Outlook
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3. Click on the [to Bluetooth] from the toolbar

 

The [Device List] window will appear.

If the [to Bluetooth] button does not appear on the toolbar, please refer to 
Installing business card-sending functionality in Outlook as an Add-in" be
and change the settings accordingly. 

4. Select the destination for the business card data, and then click on the [Send] but

 

Note

Note
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If you cannot find the destination device in the list, please click on the 
[Searching for devices] button to discover it. 

The business card will be sent.
If the business card has been sent successfully, the message below will appear.

If the transmission was unsuccessful, please attempt to send the data once m
after having confirmed the operating conditions (power status, security sett
etc) of the destination device. 

■Installing business card-sending functionality in Outlook as an Add-in

You can install one of the functions of the Bluetooth Utility in Outlook as an "Add -in", 
will enable you to send business cards from the Outlook toolbar.

1. Click on [Tools]-[Options...] in Outlook

Note

Note

Procedure
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The [Options] dialog box will appear.

2. Select the [Other] tab, and then click on the [Advanced Options...] button in the 
"General" field

The [Advanced Options] dialog box will appear

3. Click on the [COM Add-Ins...] button

The [COM Add-Ins] dialog box will appear.

4. Click on the [Add...] button
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The [Add Add-In] dialog box will appear.

5. Select "TosBTAddin.dll", and then click on the [OK] button

"TosBTAddin.dll" can be found on the hard drive at the address below.
C:\Program Files\Toshiba\Bluetooth Toshiba Stack 

6. Confirm that "Send to Bluetooth" has been added to the list and that a check appe
next to it, and then click on the [OK] button

 

ThiswillcompletetheAddinprocess

Note
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This will complete the Add-in process.

In order for a PC to connect to and communicate with a Bluetooth device, the Bluetooth Util
will create a gateway for data to be exchanged between the respective devices. This gateway 
known as a "port" (or "virtual COM port").

Since one virtual COM port will be allocated to each device, trouble -free communication w
be possible even if several devices are being used.

When you use the Bluetooth Utility, a virtual COM port will be automatically created on set
however, virtual COM ports can be created manually if so needed. 

Bluetooth Managermust be active in order for you to be able to use Bluetooth Local C

When Bluetooth communications are performed, there will always be a "client/server" 
relationship between the various devices. A "client" is a device that sends certain request
another device, while a "server" is a device that provides a service on receipt of such req
from another device. 

For example, when a PC issues a print command to a wireless printer, the PC functions a
client, while the printer functions as the server.
When a PDA or other device attempts to receive files located on a PC by means of file 
transfer protocol, the PC functions as the server, while the PDA functions as the client.

Virtual Bluetooth COM ports can be created both for clients and servers. 

Bluetooth virtual COM port for a client
Virtual COM port used when your device is the client, and requests are sent to ano
device.

Bluetooth virtual COM port for a server
Virtual COM port used when your device is the server, and requests are received fr
another device.

Bluetooth virtual COM ports are created according to the procedure below.

1. Click on the [Printers and Other Hardware] icon in the Control Panel

Note

Clients and servers

Creating a virtual COM port

Procedure

Manually creating a virtual Bluetooth COM port
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The [Printers and Other Hardware] window appears.

2. Double-click on the [Bluetooth Local COM] icon

The main Bluetooth Local COM window will appear.

Even when the Control Panel appears in Classic view, please simply click o
[Bluetooth Local COM] icon.

Note
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No such distinction between viewing formats exists in Windows 2000.

3. Click on the [Add...] button

The [Bluetooth Local COM Wizard] window, from where you can create a virtua
COM port, will appear.

Start from this window when creating Bluetooth virtual COM ports for either ser
or clients.

→Creating a Bluetooth virtual COM port for a client
→Creating a Bluetooth virtual COM port for a server 

Please follow the procedure below to delete a virtual COM port when it is no longer need

Deleting a virtual COM port

Note
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You can only delete virtual COM ports created by the Bluetooth Local COM utility

1. Select the port you wish to delete from the [Bluetooth Local COM] window, and
click on the [Delete] button

A message will appear asking you to confirm that you wish to delete the port.

2. Click on the [Yes] button

The port will be deleted.

3. Click on the [OK] button

Note
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This section provides detailed information on the [Bluetooth Settings] window. 

■[Bluetooth] menu

Main window

Menu

Category Description

Add New 
Connection

Opens the [Add New Connection Wizard] window, and then search
new devices.

Connect Connects to selected device.

DisconnectDisconnects from selected device.

Details Displays detailed information about selected device.

Bluetooth Settings
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Delete Deletes selected device.

Create shortcut 
on Desktop

Creates a shortcut icon for the selected device on the Desktop.

Rename Changes the name of the device you have selected.

Change IconChanges the icon of the device you have selected.

COM Auto 
Connect Settings

Opens the [COM Auto Connect Settings] window, and allows you t
enable/disable Auto Connect.
Displays the device connection name and port used. Check the box 
enable Auto Connect, and remove the check to disable Auto Connec
You will need to connect manuallyto use a device in the latter case

AV player 
selection

Opens [Select AV Payer] window, and allows you to select the 
application to be used when you want to play sound files or CDs.

Exit Closes the [Bluetooth Settings] window.
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■[View] menu

■[Help] menu

Displays a list of devices that have been registered in [Bluetooth Settings].

Category Description

Large iconsChanges the way icons are displayed on a device.

Small icons

List

Details

Category Description

Help Opens the Bluetooth Utility User Guide.

Version Displays the version information for Bluetooth Settings.

Device List

Function buttons

Category Description

New ConnectionOpens [Add New Connection Wizard] window.

Details...Shows details of selected device.

Delete Deletes selected device.

Creating a Shortcut

If you have created a shortcut icon on the Desktop, you can easily establish a connection to a
device that has been registered using Bluetooth Settings without having to open the Bluetooth
Settings window.

Procedure

One-touch connection to Bluetooth devices
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1. Right-click on Bluetooth icon in task tray and click on [Bluetooth Settings]

 

Alternatively, you can click [Start]→[All Programs]→[Bluetooth]→[Bluetoot
Settings]. 

The [Bluetooth Settings] screen will appear, from where you can create a Shortcut en
"Bluetooth Mouse." 

2. Right-click on the [BT-Mouse-01] icon, and then click on [Create Shortcut on Deskt

 

A shortcut icon entitled "BT-Mouse-01" will appear on the Desktop.

　　

■Establishing a connection from the Shortcut

1. Double-click on the "BT-Mouse-01" icon from the Desktop

The [Bluetooth Settings] window will open. 

Procedure

Note
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2. Turn on the mouse, set it to Bluetooth-connectable mode, and then click on the [OK
button in the [Bluetooth Settings] window.

The mouse will be connected.

After a keyboard or mouse (HID profile), printer (HCRP or SPP profiles), or other device ha
been set up for the first time, subsequent connections will be automatically restored wheneve
operate the device, print out a document from the PC, or perform another similar activity. 

Should the connection not have been properly restored, please establish a manual connection
the device using the procedure below.

1. Right-click on Bluetooth icon in task tray and click on [Bluetooth Settings]

 

Alternatively, click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Setting

The [Bluetooth Settings] screen will appear, from where you can create a Shortcut en
"BT Mouse." 

2. Right-click on the [BT-Mouse-01] icon, and then click on the [Connect] button

Procedure

Note

Manually connecting to a Bluetooth device
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The [Bluetooth Settings] window will open. 

3. Turn on the mouse, enable Bluetooth-connection mode, and click on the [OK] button
the [Bluetooth Settings] window.

The mouse will be connected.

 

If you wish to manually disconnect a device, right-click on its icon and click 
[Disconnect].

Note
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When the following message appears, click on the [Yes] button.

 

You can change a device icon that has been registered on the Bluetooth Settings screen.

1. Right-click on the Bluetooth icon in the task tray, and then click on [Bluetooth Settin

 

Alternatively, click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Setting

The [Bluetooth Settings] window will appear. Now try to change the icon for "My 
Mobile." 

2. Right-click on the "My Mobile" icon, and then click on [Change Icon]

Procedure

Note

Changing a connection icon
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A list of available icons will appear.

3. Select the icon, and then click on the [OK] button

The new icon will appear.
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You can change a the name of a device icon that has been registered on the Bluetooth Setting
screen.

1. Right-click on the Bluetooth icon in the task tray, and then click on [Bluetooth Settin

 

Alternatively, click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Setting

The [Bluetooth Settings] window will appear. Now try to change the connection nam
"My Mobile" to "Pocket PC."

2. Right-click on "My Mobile", and then click on [Change Name]

You will now be able to enter a name.

Procedure

Note

Changing a connection icon name
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3. Enter "Pocket PC", and then hit the [Enter] key

The new name will appear.

This section provides detailed information on the settings categories in Bluetooth Manager. 

Main menu

Category Description

Bluetooth 
Settings

Opens [Bluetooth Settings] window.

Wireless File 
Transfer

Open the [Wireless File Transfer] window.

Bluetooth Manager
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Remote CameraOpen the [Remote Camera] window.

Add New 
Connection

Opens the [Add New Connection Wizard] window.

Device 
Properties&Security

Displays Bluetooth device information on your PC.

[General] tab

Allows you to confirm the name, address and other settings displ
other devices.

 

[Device Name] is the only category able to be changed. If y

wish to change the name of a device, enter the new name, a
click on the [OK] or [Apply] button.

Click on the [Default] button to restore the initial settings. 

[Security] tab

Security-related (user) settings can be configured under this tab.

Note
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Click on the [Default] button to restore the initial settings.

1) Selecting Non-connectable mode will cause connection reques
rejected from any device, including registered ones. Device detec
will still be possible.

2) Selecting Non-pairable mode will make it impossible to bond 
another device in a new connection relationship. Connection will
possible when a request has been received from a registered devi
Device detection will still be possible.

3) Devices to which you have initially connected by entering a P
will not require you to do so for future connections. Connection w
be possible even if Link Level Security has been selected. 

Note

Category Description

Discoverability 
mode

Non-
discoverable 
mode

Other devices will not be 
able to detect yours.

Discoverable 
mode

Other devices will be able 
to detect yours.

Connectability 
mode

Non-
connectable 
mode

Other devices will not be 

able to connect to yours.1)

Connectable 
mode

Other devices will be able 
to connect to yours.

Pairing mode

Non-pairable 

mode2)

You will not receive 
pairing requests initiated 
from remote devices.

Pairable mode
You will receive pairing 
requests initiated from 
remote devices.

Security 
mode

Non-secure 
mode

No security will be 
enforced.

Link Level 
Security 

Enforced3)

Requires Bluetooth passkey
(PIN code) to be entered on
connection with another 
device.

Encryption
Encrypts data to be 
transmitted.

Power offTurns off Bluetooth

(Turned off)
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Communication using Bluetooth will be impossible once it

been turned off. When you next wish to use Bluetooth, plea
right-click on the Bluetooth icon in the task tray, and then c
[Power ON].

Important

→
(Turned on)

Service 
Properties

Ensures security against various kinds of access from remote dev

Here you can enable or disable the following four typical service
are accessed remotely.

This function is designed to provide robust security against

from remote devices. The "enable/disable" controls only re
access made from remote devices. You will still be able to 
remote devices from your local device, regardless of the in
settings. 

Remove the tick from each button to disable the related (se

function.

Note

Category Description

Bluetooth Information 
Exchange Service

Ticking the box enables a (server
function that allows files, images,
business cards to be transferred fr
remote device using Bluetooth 
Information Exchanger.
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PAN Networking ServiceTicking the box enables a (server
function that allows networking to
performed from a remote device u
PAN Networking Service.

Bluetooth COM Port 
Service

Ticking the box enables a (server
function that allows COM Service
performed from a remote location
the Serial Port Service.

AV Remote Control 
Service

Ticking the box enables a (server
function that allows remote contro
performed from a remote device u
AV Remote Control Service.

Help Displays the Bluetooth Utility User Guide.

Exit Exits Bluetooth Manager. 

When you exit Bluetooth Manager, Bluetooth communicati

be disabled. When you next wish to use Bluetooth, please c
[Start]→[All Programs]→[Bluetooth]→[Bluetooth Setting
Windows 2000, click on [Start]→[Programs]→[Bluetooth]
[Bluetooth Settings]). 

Important

This section provides detailed information on the settings categories in Bluetooth Information
Exchanger.

Main window

Bluetooth Information Exchanger
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Three folders are available for data exchange: "Image transfer", "File transfer" and "Obje
Push". 

Bluetooth menu

Category Description

Device DiscoveryDetects Bluetooth devices.

ConfigurationAllows detailed setting of categories related to Bluetooth Informati
Exchanger.

-[General] tab
-[Mode] tab
-[Inbox/Business Card] tab
-[Shared folder] tab
-[Image box] tab
-[Associate] tab
-[Transfer mode] tab
-[Service security] tab
-[Service class] tab
-[Information] tab
-[Version] tab

Help Displays Bluetooth Utility User Guide.

Data exchange folders
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Category Description

Click on the icon to display a list of devices. "Image box" is a folder on
transferring images.

Click on the icon to display a list of devices. "Shared folder" is a share
transferring files.

Click on the icon to display a list of devices. "Inbox" is a folder on you
business cards.
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This section provides detailed information on the settings categories in Remote Camera.

■[Bluetooth] menu

Main window

Menu

Category Description

Device SearchSearches for remote cameras.

Properties[Filter for Search Devices]

Remote Camera
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The program may discover devices other than digital cameras, depe
on which profiles are supported by those devices.

Adjusting the setting to "Loose filtering" will increase the likelihoo
devices other than those intended will be detected.
The further you slide the setting towards "Tight filtering", the strict
will be the criteria determining device detection, and the lower the 
likelihood will be that irrelevant devices will be included.

Please adjust the filtration level according to the results of the searc

[Multi Shot]

Allows you to set the number of consecutive images captured by yo
digital camera in the dialog box below (between 2 and 16 inclusive

[Pixel Size]

Images will be sent to your PC after having been automatically 
converted to the size specified in the dialog box below, regardless o
size of the original image data. 
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■[Help] menu 

　 

A list of cameras that have been registered as remote cameras will be displayed.

Clicking on this button will execute a search for remote cameras.

Images transferred to the PC from a remote camera will be displayed.

Clicking on this button will display the folders on the hard drive where images that have
transferred to the PC have been stored. 

[Inbox settings]

Opens the "Browse folders..." dialog box and allows you to select t
folder where you would like your captured images to be saved.

Exit Exits Remote Camera.

Category Description

Image monitor 
version 
information

Displays version information for the image monitor.

List of cameras

[Camera Search...] button

Display images

[Explorer...] button
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A folder for saving your images will be created automatically.

Images as seen through the lens of your remote camera will be displayed. 

　 

The size of the operating window display can be adjusted from 100% (1x) to 300% (3x).

Note

Camera operation window

Camera images

Display magnification

Important
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Increasing the size of the operating window will impede its ability to display image
and will have an adverse effect on other processes being performed by your PC. Pl
adjust the magnification as appropriate for your intended use.  

　 

Clicking on this button will display the folders on the hard drive where images that have 
transferred to the PC have been stored. 

Clicking this button will cause the camera to take the number of images specified in 
[Consecutive image settings] under the [Bluetooth] menu and then send those images to y
PC.

Clicking this button will cause the camera to take one picture and then send the image to
PC. 

[Explorer...] button

Shutter button (consecutive images)

Shutter button (single images)

Bluetooth Local COM　
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This section provides detailed information on the settings categories in Bluetooth Local COM

Displays a list of configured ports. 

Displays the function of each port.
Ports displayed as "Toshiba BT Port (COMxx)" are TOSHIBA Bluetooth virtual COM p

Displays the application used to create those COM ports.
The following information will appear for ports created by Bluetooth Local COM. 

　 

Main window

Port

Description

Owner

COM port for clientLocal COM - Client

COM port for serverLocal COM - Server [(name of service supplied by port)]

Function buttons

Category Description

Add Starts the Add COM Port Wizard.

There can be up to 64 ports. If COM ports 1 to 64 already exist, you w

not be able to add another port. 

Note

DeleteDeletes selected port.
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You can only delete COM ports created by Bluetooth Local COM. 

Note

OK Click on this button to confirm settings information, and close the Bluetooth
Local COM window.

This section provides detailed information on the settings categories in Wireless File Transfe

Displays a list of files/folders to be sent.

Displays other devices to which you are able to send files. Files will be sent to those dev
that have been checked. 

Name 
　Displays name of destination devices.

Connectionmethod

Main window

Files/folders

Devices to which data can be sent

Wireless File Transfer
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Connection method
　Displays method used to connect to other devices.

If a device to which you would like to send data is not listed, you can click on the 
[Search] button to search for other devices. 

Note

Function buttons

Category Description

Add Displays the window below, from where you can add files and/or folders yo
would like to send.

DeleteBy selecting a file from the list and clicking on the "Delete" button, you can

remove that file (i.e., the file will not be sent).

SearchSearches for Bluetooth devices.

CancelCloses the "Wireless File Transfer" window. 

Send Sends a file.

This section describes possible causes and countermeasures to be considered when your Blue
device cannot be configured properly, functions abnormally or presents other problems relate
its operation.

The section "What you need to know about using Bluetooth" describes the basic concep
be aware of when using Bluetooth. Should you still encounter problems after having read
through this information, please refer to the following list, which has been arranged acco
to application. 

Basic understanding

Troubleshooting
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toapplication.

General operation of the Bluetooth Utility

Using a wireless modem station

Using an access point

Using a printer

Using a Bluetooth headset 

Using a keyboard or mouse 

Using a camera  

Using a PDA 

Using a mobile telephone 

Troubleshooting by application

Please refer to "What you need to know about using Bluetooth" for an understandi
the basic concepts to be aware of when using Bluetooth. 

If the Bluetooth icon does not appear in the task tray, Bluetooth Manager will not b
active, which will prevent you from being able to use any of the functions of the 
Bluetooth Utility.
Start the utilities as instructed below to enable Bluetooth Manager to start automati
and allow all functions to be utilized.

Bluetooth Settings
(from Windows XP)
[Start] > [All Programs] > [Bluetooth] > [Bluetooth Settings]
(from Windows 2000)
[Start] > [Programs] > [Bluetooth] > [Bluetooth Settings]

Remote Camera
(from Windows XP)
[Start] > [All Programs] > [Bluetooth] > [Remote Camera]
(from Windows 2000)
[Start] > [Programs] > [Bluetooth] > [Remote Camera]

Wireless File Transfer
(from Windows XP)
[Start] > [All Programs] > [Bluetooth] > [Wireless File Transfer]
(from Windows 2000)
[Start] > [Programs] > [Bluetooth] > [Wireless File Transfer]

Important

Bluetooth Manager

Bluetooth icon does not appear in task tray

General operation of the Bluetooth Utility
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The wireless communication switch is turned off. 
Please switch it on.

The other device(s) may have been set to Non-discoverable mode.
Please check the mode settings on the device.

The other device may be using a profile that is not supported by the Bluetooth Util
Please check the profile being used on the other device.

The following profiles are compatible with Bluetooth Settings.

DUN, FAX, LAP, SPP, HID, HCRP, FTP, OPP, HSP, PAN and BIP

Devices running profiles other than those above will not be able to be registered wi
Bluetooth Settings.

Select and right-click on a file, and then you can choose either the FTP or OPP pro
use when you click on [Send to Bluetooth Device].
If neither profile is supported by the destination device, the file will not be able to b
sent from the right-click menu.

The transmission will also fail if you use FTP to send a file to a device that only 
supports the OPP profile.
Should this occur, please click on [Bluetooth]→[Profiles] under [Bluetooth Inform
Exchanger] to configure the Transfer mode. 

The other device may have a certain security level enforced (Non-connectable mo
etc). Please confirm the security settings of the other device.
Please enter the correct password if you are asked to enter one. 

See "Using a camera"

Bluetooth Settings

Clicking on the [New Connection] button brings up the message "Unable to prepare 
Bluetooth."

Remote device(s) cannot be detected

Services on a remote device are undiscoverable

Bluetooth Information Exchanger

An error occurs when you try to send a file using the right-click menu.

Cannot open shared folder on remote device using [File Transfer].

Remote Camera

Bluetooth Local COM

Cannot add port
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A maximum of 64 virtual COM ports can be added. You will be unable to add ano
port if 64 ports have already been configured.

Please refer to "What you need to know about using Bluetooth" for an understandi
the basic concepts to be aware of when using Bluetooth. 

If the modem station is connected to and is being used by another device, the mode
station will be undetectable even if you search for it. 

If the modem station is connected to and is being used by another device, no other 
device will be able to connect to the modem station.

The Bluetooth passkey (PIN code) comprises a sequence of alphanumeric character
with the letters able to be rendered in upper and lower case.
If [Caps Lock] is on, the Bluetooth passkey may not be able to be entered correctly

Please ensure that the telephone cable is connected from the socket to the "LINE" 
terminal on the modem station. 

If the telephone cable has come loose because it has not been fully inserted in
the socket, the resulting poor contact may prevent data from being transmitte
accurately.
Communication will be impossible if the interior of the cable has been broke
Please replace the cable with another one. 

Please ensure that the two slide switches on the underside of the main unit have be
to the "NORMAL" and "MODEM" positions respectively. 

Important

Modem station cannot be detected

Cannot connect to modem station

Bluetooth passkey entry failed

Cannot connect to telephone line

Note

C h I

Using a wireless modem station
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The telephone number of the connection (i.e., the telephone number for the access 
of your Internet service provider) may not be correct. Please check the telephone 
number.

The user ID and/or password for the provider with whom you have signed up may 
been entered incorrectly. Please check the user ID and password.
The default connection may have been configured with different settings. Please se
connection configured for mobile telephone use as the default connection.

When you place a call using a company switchboard or other exchange, the system
require you to enter a "0" before the telephone number itself. Please check the type
telephone line you are using.

Once you have registered a wireless modem station as your fax server, you will nee
enter the fax settings from the [Printer and Faxes] window in the Control Panel.
Please refer to "Using a modem station for fax transmissions" for information on t
configuration procedure.

The telephone number of the fax destination may have been entered incorrectly. Pl
check the telephone number.

If the setting under COM Auto Connect Settingshas been set to "Off", a connectio
not automatically be established with the modem. Please connect to the modem 
manually.

When you place a call using a company switchboard or other exchange, the system
require you to enter a "0" before the telephone number itself. Please check the type
telephone line you are using.

The fax service may not have been enabled for sending (or receiving).
Please check the settings by following the procedure below.

1. Open [Printers and Faxes] from the Control Panel, right-click on the [Fax]
and then click on [Properties]

The [Fax properties] window will appear.

2. Select the [Device] tab, right-click on the modem you wish to use, and the
on [Properties]

Cannot connect to the Internet

Cannot send or receive faxes
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3. Select the [Send] tab, and then confirm that "Enable device to send" has be
checked.

4. Select the [Receive] tab, and then confirm that "Enable device to receive" h
been checked (when you wish to receive faxes)
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5. Click on the [OK] button

Please refer to "What you need to know about using Bluetooth" for an understandi
the basic concepts to be aware of when using Bluetooth. 

If the access point is connected to and is being used by another device, the access p
will be undetectable even if you search for it.

If the access point is connected to and is being used by another device, no other de
will be able to connect to the access point.

The LAN cable may not be properly connected to the access point. Please check th
connection status.

If the LAN cable has come loose because it has not been fully inserted into th
socket, the resulting poor contact may prevent data from being transmitted 
accurately.
Communication will be impossible if the interior of the LAN cable has been 
broken Pleasereplacethecablewithanotherone

Important

Access point cannot be detected

Cannot connect to access point

Cannot connect to LAN

Note

Using an access point
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broken. Please replace the cable with another one.

The access point may not have been configured correctly, and may not be able to 
maintain the connection to the LAN.
Please refer to the product instruction manual for information on how to configure 
access point. 

If you are using a LAN to connect to the Internet, the LAN environment of the com
or location where you are trying to establish the connection may require you to con
via a proxy server .
Please click here for information on configuring a proxy server.

Cannot connect to the Internet

Please refer to "What you need to know about using Bluetooth" for an understandi
the basic concepts to be aware of when using Bluetooth. 

If the printer is connected to and is being used by another device, the printer will b
undetectable even if you search for it.

If the printer is connected to and is being used by another device, no other device w
able to connect to the printer.

The printer driver of the printer you are using may not have been installed correctly
Please refer to your product instruction manual and re-install the driver.

Please check to see if the printer has run out of paper, ink or other consumable item

If you are using a printer while several Bluetooth devices are connected to the PC, 
devices may not functional normally. Please disconnect the other devices and try to
again. 

Important

Printer cannot be detected

Cannot connect to printer

Cannot print/garbled print output

Using a printer
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Please refer to "What you need to know about using Bluetooth" for an understandi
the basic concepts to be aware of when using Bluetooth. 

If the Bluetooth Headset is connected to and is being used by another device, the 
Bluetooth Headset will be undetectable even if you search for it.

If the Bluetooth Headset is connected to and is being used by another device, no ot
device will be able to connect to the Bluetooth Headset. 
A Bluetooth connection will be impossible if the Bluetooth Headset is connected to
power adaptor.
Please remove the power adaptor and re-connect.

Using a Bluetooth headset with other Bluetooth devices may cause problems such a
interruptions in sound, reduced transfer speed or failure during file transfer, and 
disconnection of the other Bluetooth devices. We strongly recommend using a Blue
headset on its own, not in connection with other Bluetooth devices.

Please confirm that the Bluetooth Headset is being operated correctly (for example
ensure that the correct mode (audio or communications) mode has been selected).

Please confirm that the voice file or CD is being played back normally on your PC

Please check the volume settings on your Bluetooth Headset and PC.

If Windows Media Player or another audio-related application is active when you 
connect your Bluetooth Headset, you may find it impossible to connect properly to
Bluetooth Headset, or even to use it at all.
Please start such applications after you have connected to the Bluetooth Headset.

Important

Bluetooth Headset cannot be detected

Cannot connect to Bluetooth Headset

Sound cuts out/cannot hear anything

Please refer to "What you need to know about using Bluetooth" for an understandi

Important

Using a Bluetooth Headset

Using a keyboard or mouse
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the basic concepts to be aware of when using Bluetooth. 

If the keyboard or mouse is connected to and is being used by another device, the 
keyboard or mouse will be undetectable even if you search for it.

If the keyboard or mouse is connected to and is being used by another device, no o
device will be able to connect to the keyboard or mouse.

Keyboard or mouse cannot be detected

Cannot connect to keyboard or mouse

Please refer to "What you need to know about using Bluetooth" for an understandi
the basic concepts to be aware of when using Bluetooth. 

If the camera is connected to and is being used by another device, the camera will b
undetectable even if you search for it. 

If the camera is connected to and is being used by another device, no other device w
be able to connect to the camera.

The memory card in the camera may be full.
Please make a backup of all your necessary data on alternative media, then delete t
images from the memory card, and ascertain how much free space remains. 

The camera may not have been set to remote camera mode (image browse mode, 
configuration mode, etc).

Certain cameras will end the Bluetooth connection automatically if you change the
settings in a mode other than remote camera mode. Please re -connect to the camer
when you next wish to use the device in remote camera mode. 

Important

Camera cannot be detected

Cannot connect to camera

Images from the camera can be displayed, but no pictures can be taken

Camera images do not appear in window

Using a camera
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Please refer to "What you need to know about using Bluetooth" for an understandi
the basic concepts to be aware of when using Bluetooth. 

Please confirm that you have installed ActiveSync v3.7 or higher on your PC.

ActiveSync is installed to COM7 as a default. Please refer to "Synchronising 
information using ActiveSync" and re-configure your ActiveSync connection.
If a port other than COM7 has been used, please amend the ActiveSync connection
settings accordingly.

The type of file sent to your PDA, as well as the profile used to send the file, may 
where folders saved on your PDA are located.

Examples:
Images transferred to your PDA using "Image transfer" > saved in the "Image trans
folder
Images transferred to your PDA using "File transfer" > saved in the "Shared folder

Important

Cannot make an ActiveSync connection

Cannot locate a saved file

Please refer to "What you need to know about using Bluetooth" for an understandi
the basic concepts to be aware of when using Bluetooth. 

Ifthemobiletelephoneisconnectedtoandisbeingusedbyanotherdevice,themo

Important

Mobile telephone cannot be detected

Using a PDA

Using a mobile telephone
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If the mobile telephone is connected to and is being used by another device, the mo
telephone will be undetectable even if you search for it. 

If the mobile telephone is connected to and is being used by another device, no oth
device will be able to connect to the mobile telephone.

Please use the appropriate transfer method, according to the profiles supported by y
mobile telephone.

If OPP is supported: right-click on a file to send it

If BIP is supported: use "Image transfer" under Bluetooth Information Exchanger t
send images

The telephone number of the connection (i.e., the telephone number for the access 
of your Internet service provider) may not be correct. Please check the telephone 
number.

The user ID and/or password for the provider with whom you have signed up may 
been entered incorrectly. Please check the user ID and password.

The default connection may have been configured with different settings. Please se
connection configured for mobile telephone use as the default connection.

Once you have registered a mobile telephone as your fax server, you will need to e
the fax settings from the [Printer and Faxes] window in the Control Panel.
Please refer to "Using a modem station for fax transmissions" for information on t
configuration procedure.

The telephone number of the fax destination may have been entered incorrectly. Pl
check the telephone number.

If the setting under COM Auto Connect Settingshas been set to "Off", a connectio
not automatically be established with the modem. Please connect to the mobile 
telephone manually.

The fax service may not have been enabled for sending (or receiving).
Please check the settings by following the procedure below.

1. Open [Printers and Faxes] from the Control Panel, right-click on the [Fax]
and then click on [Properties]

Cannot connect to mobile telephone

Cannot send images to mobile telephone

Cannot connect to the Internet

Cannot send or receive faxes
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The [Fax properties] window will appear.

2. Select the [Device] tab, right-click on the modem you wish to use, and the
on [Properties] 

3. Select the [Send] tab, and then confirm that "Enable device to send" has be
checked.
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4. Select the [Receive] tab, and then confirm that "Enable device to receive" h
been checked when you wish to receive faxes)

5. Click on the [OK] button

This glossary provides definitions for Bluetooth-related terminology.
You will be able to look up the meanings of any uncertain terms here.

 

A2DP Profile 

Abbreviation of Advanced Audio Distribution.
A Bluetooth profile allowing you to adjust the sound quality of wireless headsets and ot
audio devices. 

AVRCP Profile 

Abbreviation of Audio/Video Remote Control Profile. A Bluetooth profile enabling rem
t lf ti t b t d i d R t t l d b i db

Glossary
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control functions to be sent and received. Remote control commands can be received by
Bluetooth Utility. 

Bluetooth Profile 

A specification that guarantees the connection to the service function of a remote Blueto
device.
For a Bluetooth device to send and receive information to and from another device, both
devices must support shared profiles designated for each function, such as dial -up 
networking, faxing, printing and human interface devices. 

DHCP 

Abbreviation of Dynamic Host Configuration Protocol
DHCP is a function that automatically sets up IP addresses. This function will allow you
avoid having to set up IP addresses on each computer.  

DUN Profile 

A Bluetooth profile for Dial-up Networking.
This profile enables you to establish a dial-up Bluetooth connection with a wireless mo
station, mobile telephone, or similar device.

FAX Profile 

A Bluetooth profile that enables you to establish a Bluetooth connection with a wireless
modem station, mobile telephone, or similar device to send or receive a fax. 

FTP 

Abbreviation of File Transfer Profile. 
A Bluetooth profile that enables you to browse folders on a wireless device and transfer
to and from the local device. 
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GAVDP Profile 

Abbreviation of Generic Audio-Video Distribution Profile. This is a Bluetooth profile.

HCRP 

Abbreviation of Hardcopy Cable Replacement Profile. A Bluetooth profile that establish
connection to a device only when you print, unlike SPP (Serial Port Profile). 

HID Profile 

Abbreviation of Human Interface Device Profile. 
A Bluetooth profile that enables you to connect to a wireless mouse, keyboard or other i
device. 

LAP 

Abbreviation of LAN Access Profile. 
A Bluetooth profile that enables you to establish a Bluetooth connection to a LAN acces
point to access a LAN via PPP.  

OPP 

Abbreviation of Object Push Profile. 
A Bluetooth profile that enables you to exchange business cards with a wireless device. 



Introduction 第 223 頁，共 224 頁

file://C:\Documents and Settings\anitachou\Local Settings\Temp\~hh114B.htm 2004/11/30

Passkey

Also known as a PIN code
This is a password consisting of up to 16 alphanumeric characters that enables a connec
to be established to a wireless device. You need to know the passkey in order to connec
device that requires authentication.
Even when the authentication setting has been disabled in the User Mode Properties of t
Bluetooth Utility, the passkey entry dialog box will appear automatically if authenticatio
required, enabling you to authenticate a device. A link key will be created once you hav
authenticated a device, eliminating the need for a passkey to connect to that device in th
future.

Pairing

A security function. In order for Bluetooth devices to authenticate each other, a passkey
code) is entered in each terminal when they are connected for the first time, and a secret
bit link key is generated. This action is known as "pairing."

SPP 

Abbreviation of Serial Port Profile.
A Bluetooth profile that enables communication with a device through a virtual serial po
configured for a Bluetooth connection. This can be used for printers and printer adapters
PDAs, using a method different from HCRP or ActiveSync. 

TCP/IP 

Abbreviation of Transmission Control Protocol/Internet Protocol.
Standard communications protocol (convention for enabling data communication) used 
Internet. Using the same protocol enables computers to exchange data with each other. 

 

vCARD 

Common standard for electronic business cards.
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Names, (e)mail addresses, telephone numbers and other information are exchanged in th
form of electronic business cards (in *.vcf format), allowing all parties to easily register
other's data in their address books.
The standard is extensively compatible with Microsoft Outlook, Lotus Organizer and oth
mail/schedule management software. 
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The Quick Start Guide is intended to those who wish to get started right away using Bluetooth, and 
describes basic concepts to be aware of as well as ways to connect to Bluetooth devices.

The Quick Start Guide comprises the following items.

What you need to know about using Bluetooth

Describes the basic concepts you need to be aware of when using Bluetooth devices.
It is recommended that you read this section before starting the set-up process. 

Trying out your Bluetooth device

Describes the procedures used for actually configuring and then using your Bluetooth 
device. Please read this according to your desired purpose and device. 

Troubleshooting

Describes possible causes and countermeasures to be considered when your Bluetooth 
device cannot be configured properly, functions abnormally or presents other problems 
related to its operation. 

Glossary

Explains the technical jargon used in this guide. 

You can use a Bluetooth wireless modem to connect to the Internet via a telephone line. 

→Setting up the modem station
→Connecting to the Internet 

In order to connect to the Internet, you must have already signed up with a provider and 
obtained a connection ID and password. Please ensure you have confirmed the ID, password 
andtelephonenumberofyourprovider'saccesspointbeforeyoubegintheset-upprocess

Important

Introduction

Connecting to the Internet using a modem station [DUN]
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and telephone number of your providers access point before you begin the setup process. 
Please refer to your instruction manual for information on connecting the modem station to a 
telephone line. 
A Bluetooth passkey (PIN code) is required for you to connect to the modem station. Please 
make a note of your Bluetooth passkey before you start the set-up process. 

1. Turn on the wireless modem station

2. Right-click the Bluetooth icon in the task tray, and then click on [Add New 
Connection]

 

Alternatively, click [Start]→[All Programs]→[Bluetooth]→[Bluetooth Settings], 
and then click on [New Connection] from the active [Bluetooth Settings] window. 

The [Add New Connection Wizard (Welcome to the Add New Connection Wizard)] 
window will appear. 

3. Confirm that [Express Mode] has been selected, and then click on the [Next] button

Setting up the modem station

Procedure

Note
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The [Add New Connection Wizard (Searching for Bluetooth devices)] window will 
appear.

4. Select the device name of the wireless modem station from [Device List], and then 
click on the [Next] button

The [Add New Connection Wizard (Searching for Services)] window will appear.
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Once a service has been detected successfully, connection to the device and COM port 
creation will be performed automatically, after which the [Add New Connection Wizard 
(Modem Settings)] window will appear.

5. If you are connecting to a wireless modem station for the first time, enter the passkey 
for the modem station under [Bluetooth Passkey (PIN code)], and then click on the 
[OK] button

Once the program has finished searching for the devices, the [Add New Connection 
Wizard (Device Selection)] window will appear.

6. Click on the [Next] button

Certain modems require you to configure initialization commands separately.
Please click on the [Additional initialization Command Settings] button, enter the 
initialization commands in the following window, and then click on the [OK] button.
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Please refer to the modem or mobile phone instruction manual for further details 
on the initialization commands. 

7. Enter the connection name (optional), telephone number (of your provider's access 
point), user name and password (as issued by your provider), and then click on the 
[Finish] button.

 

The sample entries shown in the window are provided solely for purpose of 
explanation. Please use your own telephone number, ID and password according 
to the arrangement with your provider. 

The settings will be registered, and an icon will appear in the [Bluetooth Settings] 
window.

Note

Important
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You can connect to the Internet by following the procedure below if the connection destination 
registered when you configured the wireless modem has been set as the default connection 
destination. 

1. Start your browser, e-mail application or other application 

Please enter the e-mail settings separately if you are going to use e-mail (the set-
up method will vary with the application). 

2. Enter the URL of the Web page you wish to display and then press the [Enter] key, or 
use the e-mail tool to send/receive items or perform other activities. 

The [Dial-up Connection] window will appear.

3. Click on the [Connect] button

A connection will be automatically established with the modem station if COM 
Auto Connect is available. If COM Auto Connect is not available, please 
manually connect to the modem station. 

The following message will appear once you have connected to the Internet.

4. End the connection 

The window below will appear if you double-click on the icon in the task bar.

Connecting to the Internet

Important

Important




